DVEfIAM
Troubleshooting

USB Driver Installation for DZ-MV350/380
Windows 98 Second Edition / Windows Me

Target:
DVDCAM Models DZ-MV350A/E, DZ-MV380A/E
Operating System Windows 98 Second Edition

Windows Me

If you failed installing the USB driver for DZ-MV350/380 on Windows 98 Second
Edition or Windows Me, please re-install the driver by following the steps described in
Section “Re-installing USB Driver Installation”, followed by Section “Confirming If
USB Driver Is Properly Installed”.

Steps 1 - 9 contain procedures for both Windows 98 Second Edition and Windows Me users. After
Step 9, please proceed to the procedures by the Operating System you use.

Targeted Operating System User

Procedure Step Page  Targeted Operating System User
Re-installing USB Dri
e-ins a_ ing river 1-9 1-4 Windows 98 Second Edition / Windows
Installation
Me users

10-29 5-9 Windows 98 Second Edition users only

10-29 10 - 14 Windows Me users only

Confirming If USB Driver

Is Properly Installed 1-10 15-17  Windows 98 Second Edition / Windows

Me users

Re-installing USB Driver Installation

1 Connect DVDCAM to the PC, and power on the DVDCAM to the VIDEO
position.

2 Open My Computer, double-click Control Panel, and then double-click
System.
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3 Click the Device Manager tab.
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4 Double-click Universal Serial Bus controllers, one of the branches in the
Device Manager. The branch that you double-clicked will be expanded.
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5 If any device name appearing with a yellow “!” or “?” or red "X" mark, right-
click it and select Uninstall to delete it.

Sample of a device appearing with a yellow “!” mark
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6 If Other devices exists in the Device Manager, double-click it. Right-click a
device appearing with a yellow “!” or “?” or red "X" mark, and then click
Uninstall.
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7 If any other devices appearing with a yellow “!I” or “?” or red "X" mark exist,
select the device, and then uninstall it all.

8 Click OK, and close the Device Manager. If a message of restart is
prompted, click No.

9 If you use Windows 98 Second Edition, proceed to
Page 5.

If you use Windows Me, proceed to Page 10.



Windows 98 Second Edition
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Open My Computer.
From the View menu, click the Folder Options, and then click the View tab.
Under Hidden files, select Show all files and click OK.

(231 Hidden files
) Do not show hidden or system files
3 Do not show hidden files

BC) ol
With My Computer, open Windows folder in the hard drive, and then open
the inf folder.

If a Warning message appears to view the contents of the Windows folder,
click Show Files.

Find the Hitachi Ltd.DZ3298 and Hitachi Ltd.DZ32ME files in the Other
folder.

If any of the Hitachi Ltd.DZ3298 and Hitachi Ltd.DZ32ME files in the Other
folder exist, delete it all.

Disconnect the DVDCAM from the PC.

Close all applications, and restart Windows.

Close any running applications. If any anti-virus software is running, disable
the software during the installation.

Insert the DVDCAM Software CD-ROM supplied with DVDCAM the into the
CD-ROM drive.

Note
Be sure to connect to an unused USB port on the back of your PC.
Do not use USB ports on a USB hub or the front panel of the PC

Power on the DVDCAM to the VIDEO or PHOTO position, and then connect
the DVDCAM with the PC.

The red ACCESS indicator of DVDCAM will turn off and will be followed by a
beeping sound. At this time, the ACCESS indicator, LCD, and viewfinder are
all off.



21 When the PC recognizes to find the DVDCAM, Add New Hardware Wizard
appears as shown below,

Tip  If the Add New Hardware Wizard dialog box does not appears, perform
any of the following procedures (a. to d.) and redo the above steps 16 to 20.

a Use another USB port on the PC.

b Power off both the PC and DVDCAM, and then power on them.
¢ Remove the DVD-RAM/DVD-R disc.

d Power on the DVDCAM to the PHOTO position.

Windows 98 Second Edition Add New Hardware Wizard

Add New Hardware Wizard

Thiz wizard searches for new drivers for:

LUSE Device

A device driver iz a softvare program that makes a
hardware dewvice wark.

Cancel |

22 Select Search for the best driver for your device (Recommended), and
then click Next.

Add New Hardware Wizard

what do vou want Windows o do?

% Search for the best driver for your device., Select

" Display a list of all the drivers in a specific
lozation, 20 you can select the driver you want.

¢ Back Cancel |




23 Clear the Floppy disk drives and CD-ROM drive check boxes. Select the
specify a location check box.
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24 Click Browse.

Add New Hardware Wizard

Windows will search for new divers in its diver database
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locations. Click Mexst to start the search.
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25 Specify the Win98 folder under the USB2 folder from the DVDCAM Software

CD-ROM, and then click OK.

26 Click Next.
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27 Confirm that the following USB driver file location that the PC found appears,
and then click Next. If it does not appear, click Back and select the correct
USB driver file as shown in Step 25.

drive-letter : \ USB2 \ WIN98 \ DZ3298.INF

Add New Hardware Wizard

Windows driver file searchifor the device:

Hitachi DYDCAR LISE BS Interface

Windows 1z now ready to fstall the best driver for this
device. Click Back to seldct a different driver, or click Mest
to continue,

# Location of driver:
o~ * Q D:ASE WM IBADEZ3298 INF ]

¢ Back Cancel |

28 When the USB driver installation finishes, click the Finish button.

Add New Hardware Wizard

% Hitachi DWDCAK USE HS Interface

Windows haz finizhed instaling the software that pour new
hardware device requires.,

& Hack Cancel |

29 Proceed to Page 15 “Confirming If USB Driver Is
Properly Installed-

Note

To access the DVDCAM from PC, you need to install the UDF (DVD-RAM) driver,
DVD-MovieAlbum, and MyDVD. For installing those programs, please refer to
Sections INSTALLING UDF DRIVER, INSTALLING DVD-MovieAlbumSE, and
INSTALLING MyDVD in the "Instruction Manual" supplied with the DVDCAM.




Windows Me

10 Open My Computer.

11 From the Tools menu, click the Folder Options, and then click the View tab.
12 Select Show hidden files and folders and click OK.
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With My Computer, open Windows folder in the hard drive, and then open the inf
folder.

If a Warning message appears to view the contents of the Windows folder, click Show
Files.

Find the Hitachi Ltd.DZ32ME and Hitachi Ltd.DZ3298 files in the Other folder.

If any of the Hitachi Ltd.DZ32ME and Hitachi Ltd.DZ3298 files in the Other folder
exist, delete it all.

Disconnect the DVDCAM from the PC.
Close all applications, and restart Windows.

Close any running applications. If any anti-virus software is running, disable the
software during the installation.

Insert the DVDCAM Software CD-ROM supplied with DVDCAM the into the CD-ROM
drive.

Note
Be sure to connect to an unused USB port on the back of your PC.

Do not use USB ports on a USB hub or the front panel of the PC

20

Power on the DVDCAM to the VIDEO or PHOTO position, and then connect the
DVDCAM with the PC.

The red ACCESS indicator of DVDCAM will turn off and will be followed by a beeping
sound. At this time, the ACCESS indicator, LCD, and viewfinder are all off.
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21 When the PC recognizes to find the DVDCAM, Add New Hardware Wizard appears
as shown below,

Tip  If the Add New Hardware Wizard dialog box does not appears, perform
any of the following procedures (a. to d.) and redo the above steps 16 to 20.

a Use another USB port on the PC.

b Power off both the PC and DVDCAM, and then power on them.
¢ Remove the DVD-RAM/DVD-R disc.

d Power on the DVDCAM to the PHOTO position.

Windows Me Add New Hardware Wizard

Add New Hardware Wizard

Windows has found the following new hardware:
USE Device
Windows can automatically search for and install software

that zupportz your hardware. IF yaur hardware came with
installation media, insert it now and click Mext.

Wwhat would pou ke to do?

0 #wtomatic search for a better driver [Recommendedk

" Specily the location of the diiver [Advanced)

¢ Back I Mext » I Cancel

22 Select Specify the location of the driver (Advanced), and then click Next.

Add New Hardware Wizard

Windows has found the following new hardware:

USE Device

Windows can automatically search for and install software
that zupportz your hardware. IF yaur hardware came with
installation media, insert it now and click Mext.

Wwhat would pou ke to do?

" Automatic search for 3 better diver [Recommended)

[+ Speciy the location of the diver [Advancedf Select

¢ Back I Mext » I Cancel
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23 Clear the Removable Media (Floppy, CD-ROM drive...) check box. Select
the Specify a location check box.

Add New Hardware Wizard

Windaowes will search for new drivers in its driver databaze
on your hard dive, and in any of the following selected

¥ Search for the best driver for your device.
[Recommended].

[~ FRemaovable Media [Floppy, CO-ROM. ] <= Clear the check mark!

v Specify a location: I
[EAUSB24wintE |

" Display a list of all the divers in a specific lozation, so
you cah zelect the driver pou want,

< Back | MHest > | Cancel

24 Click Browse.

Add New Hardware Wizard

Windows will search for new divers in its diver database
an your hard drive, and in any af the following zelected

% Search for the best driver for your device,
[Recommended].

[~ Removable Media [Floppy, CO-ROM...]
¥ Specify a location:

Click Browse

[EAUSB24winME =]

" Display a list of all the drivers in a specific location, so
wou can zelect the driver you want,

¢ Back Mest » Cancel
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25 Specify the WIinME folder under the USB2 folder from the DVDCAM
Software CD-ROM, and then click OK.

Browse for Folder e

Select the folder that containg driver information [IMF file] far
thiz device.

24 3% Floppy 4] =]
#-= Local Disk [
#-= Local Disk (D7)
=45 DVDCAM3 [E:)
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F:I---‘-ﬁ:' T armnarct Cise (F-1

26 Click Next.

Add New Hardware Wizard

Windows will search for new divers in its diver database
an your hard drive, and in any af the following zelected

% Search for the best driver for your device,
[Recommended].

[~ Removable Media [Floppy, CO-ROM...]
¥ Specify a location:
[EAUSB24winME =]

" Display a list of all the drivers in a specific location, so
wou can zelect the driver you want,

¢ Back I Mest » i—mm Click Next
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27 Confirm that the following USB driver file location that the PC found appears,

and then click Next. If it does not appear, click Back and select the correct
USB driver file as shown in Step 25.

drive-letter : \ USB2 \ WINME \ DZ32ME.INF

Add New Hardware Wizard

Windows driver file searchifor the device:

Hitachi DYDCAR LISE BS Interface

Windows 1z now ready to fhstall the best driver for this
device. Click Back to selget a different driver, or click Mest
to continue,

Location of driver:

Q E:AUSE24WINMESDZI2ME.IMF ]

¢ Back Cancel

28 When the USB driver installation finishes, click the Finish button.

Add New Hardware Wizard

% Hitachi DWDCAK USE HS Interface

Windows haz finizhed installing the new hardware device.

¢ Back

Cance| |

29 Proceed to Page 15 “Confirming If USB Driver Is
Properly Installed”

Note

To access the DVDCAM from PC, you need to install the UDF (DVD-RAM) driver,
DVD-MovieAlbum, and MyDVD. For installing those programs, please refer to
Sections INSTALLING UDF DRIVER, INSTALLING DVD-MovieAlbumSE, and
INSTALLING MyDVD in the "Instruction Manual" supplied with the DVDCAM.
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Confirming If USB Driver Is Properly Installed

Please confirm if the USB driver for the DVDCAM is working
properly by the following procedures after re-installation.

1 Open My Computer, double-click Control Panel, and then double-click
System.

2  Click the Device Manager tab, and then click Hitachi DVDCAM USB HS
Interface under Universal Serial Bus controllers .

3 Click the Properties button.

System Properties HE |

General Device Manager I Hardware F'rafilesl Petfurmancel

* View devices by lwpe ™ Yiew devices by connection

B Parts [COM & LPT) =]
G- Spstemn desvices

=82 Uriversal Serial Bus contrallers

Hitachi DYDCAR USE HS Interface
IJ5E Mazs Storage Device For DWVDCAM
[J5B Root Hub

IJSE Root Hub
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>

- || —=ad Select Hitachi DVDCAM USB HS Interface, click Properties.

|
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5

(=]

Check the Device status box on the General tab of Hitachi DVDCAM USB
HS Interface Properties dialog box.

If the USB driver is properly installed, the Device status shows "This device
is working properly."

Hitachi DVYDCAM USE HS Interface Froperties HE
General I Diriver I

i@ - Hitachi VD CAM USE HS Interface

Device twpe: Univerzal Serial Bus controllers
M anufacturer: Hitachi Ltd.
ardware wersion: Mot available

— Device status
Thiz device iz working properly. >

— Device uzage

[ iizablz i this hardware profils

¥ Esists i all hardware profiles

Ok I Cancel

For Windows 98 Second Edition users, Click the Device Manager tab, and
then click USB Mass Storage Device For DVDCAM under Universal Serial
Bus controllers .

For Windows Me users, double-click Storage device, and then click USB CD-ROM.

=47 Storage device
% USB CD-ROM

Click the Properties button.

Check the Device status box on the General tab of USB Mass Storage
Device For DVDCAM Properties dialog box.

If the USB driver is properly installed, the Device status shows "This device
is working properly."
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8 Click the Device Manager tab, and then click HITACHI DVD-RAM DZ-MV3
under CD-ROM .

System Properties HE |

General Device Manager I Hardware F'rafilesl Petfurmancel
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]--@ keyboard
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] Lo Hitacki POCER ISR HS Inbarfars

H
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H
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H
£

Froperties | Refresh | Remaove | Print... |

DK I Cahcel |

9 Click the Properties button.

10 Check the Device status box on the General tab of HITACHI DVD-RAM DZ-
MV3 Properties dialog box.
If the USB driver is properly installed, the Device status shows "This device
is working properly."

Note

To access the DVDCAM from PC, you need to install the UDF (DVD-RAM) driver,
DVD-MovieAlbum, and MyDVD. For installing those programs, please refer to

Sections INSTALLING UDF DRIVER, INSTALLING DVD-MovieAlbumSE, and
INSTALLING MyDVD in the "Instruction Manual" supplied with the DVDCAM.
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